
What is Real-time Collaboration?
Real-time Collaboration (RTC) gives you the
ability to work with a co-worker down the hall,
at another NREL facility, or even NREL DC. 
Today's communication tools, along with
faster networks, gives you the ability to use a
camera, headset and software and never
leave your office.

Real-time Collaboration is more than just
video conferencing, as employees can not
only see and hear each other, they can share
a single application, like Word or PowerPoint
and even transfer files. Video and sound are
combined with application sharing to give two
or more users a virtual meeting place on the
network.

Quick Start
Video Conferencing with TeamStation.

Locations of TeamStations
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MORE than just Video Conferencing...
Real-time Collaboration is here at NREL, with phased expansion of RTC capabilities
planned for labwide, and eventually nationwide access. NREL is currently deploying the
Intel TeamStation System as its standard video conferencing unit in locations around
the lab and at other NREL facilities, including NREL DC.

The Intel TeamStation System differs from traditional room conferencing systems in
that, in addition to video conferencing, it has all the capabilities of your desktop PC --
browse the Internet, give PC-based presentations, link to the corporate network, and
access files from a desktop PC. Even take a Snapshot Video of during a conference
and save it to file!

In addition to reducing travel, the Intel TeamStation System improves productivity by
turning meetings that previously consisted of status updates and action-required
assignments into productive working sessions. Conference attendees collaborate and
actively work with files and data "real-time" for maximum productivity.

The Intel TeamStation System is also productive off the call, meaning that even if
employees are not doing a video conference, they can still use the PC features of the
system, as well as its multimedia capabilities. With the systems installed, the challenge
now is to get employees to think differently about how to conduct meetings and how to
use the new systems as a productivity tool.
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About Intel® TeamStation™ System
Quick Start
Set Up and Log On
Preload and Preview Shared Documents
Establishing A Call
Shared Documents and Collaboration
Data Tools
Video Options
Camera Remote
Support

    

The Intel TeamStation System is a conference room workstation that combines
videoconferencing, Internet access, corporate network access and PC applications in
one convenient system. Based on the Intel Pentium® III processor, the Intel
TeamStation is a turnkey, high-performance system that brings increased productivity to
conference rooms.

Collaborate in the Conference Room:  Take action and get results by using simple
pull-down menus to work collaboratively on documents during the videoconferencing
session. You can also share applications, transfer files and use the white-board as well
as clipboard. These enhanced capabilities are provided by Microsoft NetMeeting which
is seamlessly integrated into the Intel TeamStation System, providing  point-to-point and
multi-point data collaboration.

Effortless Document Management:  The Intel TeamStation System enables
conferees to share documents during a videoconference or electronic presentation.
Collaborators can preload files from their network U:\ drive to the TeamStation system
for sharing during a group videoconference. Applications can also be shared, allowing
any conferee the ability to directly edit the documents

World-Class Audio/Videoconferencing:  With wideband audio and clean, crisp video
quality, the Intel TeamStation System offers the highest quality multimedia environment
for your group videoconferences. Sophisticated peripheral equipment, including an
omni-directional microphone, 10X amplified built-in speakers, and an on-screen near-
and far-end camera control enables every participant to be easily seen and heard
during the call.

Off-the-Call
Networked Connectivity:  Even when not videoconferencing, the Intel TeamStation
Systems workstation and large display are critical productivity tools.  Give
presentations, collaborate on documents or review financials in the conference room.
During a meeting you can also access corporate applications, information and files
stored on the corporate intranet or the public Internet.
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 Quick Start Video Conference
Power on the TeamStation and set up the keyboard.
Log on* to the Intel TeamStation System by entering a user name and password.
     *If Ready to Dial view is displayed, you do not have to log on.

1 Click the Video Call
button.

4 Click the Hang Up
button to end the
conference.

2 Enter the number and
click the Call Now
button.

3 The Audio/Video
Conference connects.

 Quick Start Video/Data Conference
Power on the TeamStation and set up the keyboard.
Log on* to the Intel TeamStation System by entering a user name and password.
     *If Ready to Dial view is displayed, you do not have to log on.

1

2

At Your Desktop:

Collect your documents.
Copy all your documents to your network U:\ drive. Be sure to
copy documents from CD-ROM or floppy disks to the network as
well.

In the Conference Room:

Click the Preload Documents button.
Note:  Make sure the applications you used to create your
documents are installed on the TeamStation System.



3a

4

5

6

7

Add Documents.
Click the Browse button to
find your documents on
your U:\ network drive.

3b Document Server.
Click the Next button
again as Document Server
is not currently supported.

Click the Preview button.
You can preview your documents to ensure they will disply
correctly on the TeamStation System.

Click the Call button to immediately make a call.

Click the Wait button to receive a call.

Once you are in a conference, your documents are listed in
the Documents to Share window.
Note:  Double-click the Add Document entry to add documents
to a conference session.

Click the Share button.
Select a document and click the Share button to launch and
share the document with the far-end participant.
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Set Up and Log On
Set Up:  Simply turn on the power strip located on the Intel TeamStation System cart to
have the PC, monitor, and camera all powered up.

Infra-red Keyboard:  Be sure to place the infra-red keyboard within direct line of the
infra-red sensor attached to the cart. The trackball is located on the right side of the
keyboard, with the click-select buttons on the top left of the keyboard. Click the top
button for a left-click and the bottom button for right-click.

Log On:  When the TeamStation boots up, you will be prompted for your user name
and password. If it is the first time you have logged on to this system, it will take a few
moments for your account to be created. Once you have logged on, wait for the Ready
to Dial screen of the Intel TeamStation System.

Remote Control:  The remote control unit located on the cart is used to remotely
control camera functions, volume settings, auto-tracking, etc.

Shut Down:  When your video conferencing session is over, please remember to
Shut-down the system by logging off and turning off the power strip. Note that the only
options available are Shut-down and Restart; there is not an option to log on as a
different user.
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Standard Applications Installed on
TeamStation Systems

Microsoft Office 97:  Includes Word, Excel, Powerpoint, and Access.

Microsoft Internet Explorer 5

Acrobat Reader 4.05

Aladdin Expander 5.0

Quick View Plus 4.5

WinPH 1.5

Note: For files which are not viewable by any of the above applications, it is
recommended that a PDF file be created and Acrobat Reader utilizied for file sharing
during a conference. Keep in mind that PDF files are not editable from Acrobat Reader.
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Preload and Preview Shared Documents
Overview: This section steps you through preparing the list of documents that will be
available during the conference. It helps you add documents from your network U:\
drive mapped to the system. It also lets you preview the documents. During the video
conference, the list of preloaded documents is displayed for you in the Documents to
Share window where they can be selected for sharing.

Note: NREL´s TeamStation units have most of the PC desktop standard applications
installed.  When you share a document, the Intel TeamStation System starts an application
that the system associates with the document's filename. For example, if your document
name has a .DOC at the end of its filename, the system will start Word. If the correct
application is not starting for you, contact Client Services at x4171 for assistance.

Adding Documents from Network Servers: Add documents first from your desktop
by copying files from your hard drive, other network drives, or any removable media, to
your User Directory (the U:\ drive) of your Network Server. (Mac Users will mount their
User Volumes to the desktop). Please keep in mind that User Directories have a 200Mb
size limitation. Then, from the TeamStation system, click Preload Documents and use
the Browse button to locate, select, and add files from your U:\ drive on the Network
Server to the Documents to Share list.

Note: If you require files originating on diskettes, CD´s, Zip, Jaz, etc., please copy them
first from your desktop computer to your network server. Do not use removable media
directly from the TeamStation computer.

Removing Documents: To remove documents from the Documents to Share list,
select them and click the Remove button.

Note: Files originating on your network drive are only removed from the list; they are not
deleted from the network drive.

Preview: After the documents list is preloaded, you can preview the documents by
clicking the Next button. A Preview Documents page will appear.  Select the document
in the Documents to Share list. Click the Preview button to open the document and its
associated application.

Note:  Using Preview lets you make sure that the documents listed are the ones you want
and that they will be displayed correctly during a conference.

If you get a file association error, the application you need to display the document is
not available on the TeamStation or has not been correctly associated for the type of file
you have. Contact Client Services x4171 fro assistance.

Editing: The document can be edited at this time.

Closing the Application: After you have the document the way you would like it to
appear when it is shared in the conference, close the application. You can now preview
other documents in the list.

Calling or Waiting: After previewing documents, you can either make a video call or
have the system wait to receive a call. To make a call, click the Call button; to wait for
an incoming call, click the Wait button.  Documents you have prepared with the Preload



Wizard will be available in the Documents to Share list after you answer the call.

To leave Wait For a Call View, click Cancel and the system will return to the Ready To
Dial View.

Note: Canceling the Wait For A Call View does not delete the documents in your
Documents to Share list. If you want to change the documents in the list after canceling,
click the Preload Documents button and make changes as needed.
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How do I mount my User volume?
1.The User volumes hold shared folders for every user at NREL.  You should find
your User volume on your home server.

2.Go to the Chooser and choose AppleShare (in the upper left of the Chooser
window).

3.Find your home file server:
Denver West: NT-FILESVR-1A IP (in the BACKBONE2 segment)●   

NWTC:  NT-FILESVR-2A IP (in NWTC segment)●   

SERF:  NT-FILESVR-3A IP (in SERF EAST segment)●   

FTLB:  NT-FILESVR-3B IP (in FTLB/SOUTH segment)●   

BLDG 27:  NT-FILESVR-4A IP (in 27/1 segment)●   

DC Office:  NT-FILESVR-5A IP (in NREL-DCO segment)●   

4.Click on the correct server in the server list.  Be certain to click on the server that
ends in IP so you will use TCP/IP to access the server.  You can also click on the
Server IP Address… button and enter the host name (i.e., ‘nt-filesvr-1a.nrel.gov').

5.Click on the OK button and enter your username and password.

6.Highlight the User volume and click OK. (Only check the box next to that volume
if you want it to mount every time you startup your Mac.  This slows startup times,
wastes network bandwidth and slows down the network. It is better to make an
alias of the volume and double-click on it to quickly mount the volume).

7.The User volume will appear on your desktop.  You should find your User Folder
inside.  If you don't, please make sure you are accessing the correct server for
your location.  Contact the Help Desk (x4171) if necessary.
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Establishing a Call
Ready to Dial View:  This is the first screen displayed after logging on to a
TeamStation System. The TeamStation System is ready to receive a call whenever you
are in the Ready to Dial View (the system´s number is listed at the top of the screen).
Otherwise, click the Video Call button to initiate a point-to-point or multi-point video
conference from this station.

 

Point to Point:  A point to point call is simply a video or video/data conference
established between two stations.

Multi-point:  A multi-point call is similar to a conference call on a telephone in which a
video or video/data conference is established between multiple stations. Multi-point
calls may be initiated from a TeamStation unit by selecting "0@NREL" from the
directory.

Note:  Telephone calls directly from TeamStation systems are not supported.

Video Call View:  When a video connection is established the Video Call View screen
is displayed with the following elements:

The video image from the far-end system appears in the main area of the screen.●   

The local video image is displayed in the smaller window.●   

You can hear the audio from the far-end system.●   

On-screen volume, mute, and camera buttons are visible at the bottom of the
screen.

●   

Using the Volume (Vol), Mute, and Camera Controls:  These controls at the bottom
of the Video Call View can also be accessed from the Video Options menu.  They allow
you to control the volume, mute the audio or audio+video during the conference, and
control the motorized camera.

To mute the system, click the Mute button. When your mouse pointer passes over



the Mute button, one of these muting icons is displayed.

   

When the system is muted, the X in the Mute button turns red and remains
pressed in. Also the on-screen muting icon appears with a red mark through
it.Click the Mute button again to unmute the system.

Full-Screen Video View:  If you would like to increase the size of the far-end video
image to full-screen, select Full Screen from the Video Options menu. Or press the Ctrl
and F keys at the same time.

Sharing Documents:  Depending on the type of system you call, your conference can
also include data conferencing (some video conferencing systems are not able to share
data). One way to know if the far-end system is capable of data conferencing is if the
Data Tools button is available.

 

Controlling Documents in the List:  Only documents in this list can be shared. It
is helpful to Preload and Preview documents you wish to share prior to initiating or
receiving a call. However, during a conference, you can still add or remove
documents by double-clicking <Add Document> in the Documents to Share
window. Locate your document on the network server or the Document Server to
have it added to the Documents to Share list.

Starting Document Sharing: Double-click a document in the list or select the
document by clicking its filename and then click the Share button.  When
document sharing begins, the TeamStation System switches to Document View.

Collaboration: When the near-end system shares a document, viewers at the
far-end system can also view it. To allow them to edit the document, you must
enable Collaboration.

Using the Data Tools:  Click the Data Tools button for a list of the tools available. They
include Chat, File Transfer, and Whiteboard tools, and also Document Server which is
currently not supported.

Note: Any open Intel TeamStation System dialog automatically closes when a call is
received.

Ending the Call:  To end a call, click the Hang Up button.

Who to Call for Support: Client Services at x4171.
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Document Sharing and Collaboration
Document Sharing enables the far-end conferees to view a document. Collaboration
gives the far-end conferees the ability to directly edit documents being shared in a
conference.

Note: Sharing is only available if a data channel is available in a video conference. Look
for the Data Tools menu on the left side of the Intel TeamStation System window. It is only
displayed when a data channel is available.

Available Desktop Applications:  NREL´s TeamStation units have standard
applications installed on the TeamStation computer. When you share a document, the
Intel TeamStation System starts an application that the system associates with the
document's filename. For example, if your document name has a .DOC at the end of its
filename, the system will start Word. If the correct application is not starting for you,
contact Client Services at x4171 for assistance.

Document View:  Shared documents are displayed in the large area of the screen and
the far-end video image automatically moves to the smaller display area at the upper
left. (No near-end video image is available in this view.)

 

Viewing Video: To return to the large video image, click the Show Video button.

Sharing Menu:  When the near-end system shares a document, viewers at the far-end
system can also view it. To allow them to edit the document, you must enable
Collaboration. Select the icon for the Sharing Menu ( ) at the top of the document
window. The Sharing Menu lets you control the sharing and collaboration of any running
application.



                                    

Share This Application:  To start sharing an application that was NOT launched
using the document sharing capability of the Intel TeamStation System, start the
application by selecting it in the Windows Start menu. If you are in a conference,
click the Sharing Menu icon in the application's caption bar. In the resulting menu,
choose Share This Application.

Start Collaborating:  When sharing, conference participants at the far-end
system can view the document currently being shared, but they cannot edit it. To
let them edit the document, you must enable Collaboration by choosing Start
Collaborating from the Sharing Menu. To end Collaboration, choose Stop
Collaborating from the Sharing menu.

Note: Collaboration affects all shared applications.

Gaining Control of the Cursor during Collaboration:  If you initiated the application
sharing, you can gain control of the cursor by clicking once in the window of the shared
application.  If you did not initiate the application sharing, you can gain control of the
cursor by double-clicking in the window of the shared application.

Sharing Applications that Use the Whole Screen: Some applications, such as
Microsoft PowerPoint, have the capacity to use the whole screen.  While the application
is using the full screen, the far-end video is displayed as a small floating video window. 
To move the floating video window, hold your left mouse button as you point to the
window and move the mouse. Use the menu button above the floating video window to
control the window display
                                        

Stopping Sharing: To stop sharing an application, simply close the shared application,
or click the application and Choose Stop Sharing in the Sharing Menu ( ) at the
top right corner of the document window.

Using the Data Tools: Click the Data Tools button for a list of the tools available. They
include Chat, File Transfer, and Whiteboard tools, and also Document Server which is
currently not supported.

Ending the Call:  To end the call, select the Hang Up button.
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Data Tools
Click the Data Tools button for a list of the tools available. They include Chat, File
Transfer, and Whiteboard tools, and also Document Server which is currently not
supported. After a data application is running, use the application's Help to learn more
about how to use the tool. These functions utilize Micrsoft´s NetMeeting application

Note:  If you select Chat or Whiteboard, the tool also starts on the far-end system.

Chat
After NetMeeting´s Chat application is running, use the application's Help to learn more
about how to use this tool.
                           

File Transfer
When the File Transfer tool is selected, you will be prompted to locate the files you wish
to transfer. There is also the option to view the list of files that have been received. After
the File Transfer application is running, use the application's Help to learn more about
how to use this tool.

Whiteboard
After NetMeeting´s Whiteboard application is running, use the application's Help to learn
more about how to use this tool.
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Video Options Menu
Full-Screen Video View:  If you would like to increase the size of the far-end video
image to full-screen, select Full Screen from the Video Options menu. Or press the Ctrl
and F keys at the same time.

Note:  The Full Screen option is only available during a conference.

In this view, the video image is enlarged to fill the entire screen and the
Picture-In-Picture video window is displayed on top. The Video Options button is also
available.

Hiding Picture-In-Picture Video Window: If you would like to hide the
Picture-In-Picture video window so that only the large full-screen video image is
displayed, select Video Options > Picture-In-Picture. Note that hiding the
Picture-In-Picture video window is only possible in Full Screen View.

Viewing Documents: If you've used the Document View earlier in the
conference, you can switch to Document View by clicking the Show Documents
button. (This button is only available if you have used Document View earlier in
the conference.)

Returning to Video Call View: To return to Video Call View, select Video
Options > Full Screen, or press Ctrl-F.

Switch Video Positions:  Automatically displays the video of the near-end system in
the main video window. The secondary video window displays the video of the far-end
system.

Tone Pad:  Displays a key pad that generates touch-tone sounds. The Tone Pad option
is only enabled during a video call (and it is not available in full-screen view or when a
document is being shared). Use the Tone Pad when you need tones to select
conference options from the far-end system, or enter an extension when calling a
gateway.

System Information:  Displays information about your Intel TeamStation System and
about the connection types that are enabled. Look here also for information about your
system administrator in case of questions about the operation of your system.

Main Camera:  Selects the video input from the main camera.

Secondary Camera or VCR:  Selects the secondary video input, (if connected) which
can be a second camera, a VCR, or other kinds of video devices. Contact your system
administrator for information on the video inputs connected to your Intel TeamStation
System.

Video Image Settings:  Displays on-screen video image controls. Use these controls to
adjust the Brightness, Contrast, and Saturation of the near-end video image.

Camera Controls:  Displays on-screen controls for the motorized camera. Use the
on-screen controls to move the camera up and down, left and right, and to zoom in and
out. (When you select a non-motorized video device, the Camera Controls option is not
enabled.)



Snapshot Video:  The TeamStation System can take a snapshot of the near or far-end
video window and places it in the Windows Paint application so that you can view it,
share it, or save it to a file.

To open the Snapshot window, select Snapshot Video from the Video Options
menu (or type Ctrl + S).

1.  

Click the Snapshot button to take a snapshot of the currently selected video
image and to place it in the Microsoft Paint program. To save the snapshot, in
Paint select File > Save. Enter a name for the bitmap file and choose where to
store it.

2.  

If you are in a conference, the Paint application is not automatically shared. To
share your snapshot, select the Sharing Menu icon ( ) at the top of the
Paint window. From the resulting menu, select Share This Application.

3.  
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Camera Remote Control Functions
Pan/Tilt Operation
Adjusting the Camera
Presetting Feature
Auto Tracking Function
     Changing the Frame Position
     Auto Tracking Troubleshooting
Motion Detector Function

 

 

1. BACK LIGHT button 8.  CAMERA SELECT buttons (for use when more
than one camera is used at a location)

2.  FOCUS buttons:
        AUTO button
        MANUAL button
        FAR button
        NEAR button

9.  AT (Auto Tracking) mode buttons
           AT ON/OFF button
           OFF SET button
           ENTRY button
           CHASE button
           AE (automatic exposure) button
           AUTO ZOOM button



3.  DATA SCREEN button
        START/STOP button
        FRAME DISPLAY button

10.  MD (Motion Detector) mode buttons
           MD ON/OF button
           FRAME button
           DETECT button

4. MENU button 11.  POSITION buttons
           Numeric buttons
           Button 1 also works as the STD button
           Button 2 also works as the REV button

5. CURSOR button 12.  PAN-TILT/CURSOR button
           Arrow buttons
           HOME button

6. L/R DIRECTION SET button 13.  PAN-TILT RESET button
7. POWER switch 14.  ZOOM buttons

           SLOW T (telephoto) button
           SLOW W (wide-angle) button
           FAST T (telephoto) button
           FAST W (wide-angle) button

1.  CAUTION lamp 4.  LENS
2.  POWER lamp 5.  INFRA-RED RECEPTORS for Remote Control
3.  RECEIVE lamp  
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Pan/Tilt Operation
 

Basic Operations: The camera should have been powered on when you turned on the
TeamStation system. If not, press the POWER button on the remote, and the camera
will turn on and perform the pan/tilt reset action automatically.

While checking the picture on the screen, press a desired ARROW button.

To move the camera inch by inch, press the button for a moment.
To move the camera in a wide range, press and hold down the button.
To move the camera diagonally, press two adjacent arrow buttons.

To face the camera back to the front: Press the HOME button.

If you accidently move the camera with your hand:  Press the PAN-TILT RESET
button to reset the pan/tilt position. The deviation from the position that the camera
memorizes will be corrected and the operation will be back in order.

To reverse the arrow buttons:  The camera is preset to move toward the right (STD
setting) whenever the right arrow ( ) button is pressed (from the camera´s

perspective). This means that if you are facing the camera, the right arrow button
moves the camera to the left. You can reverse the arrow buttons so that the camera
moves to your right when you press the right arrow button by using the REV setting.



 

If the lamp at the side of the lens flashes red: The micro computer inside the camera
might not memorize the current pan/tilt position properly. Press the PAN-TILT RESET
button to reset the pan/tilt position.

 

Operating range of the remote: Use the remote within the range described below,
facing it toward the receptor at the front of the camera.
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Adjusting the Camera
 

Focusing on a Subject:  Press the AUTO button to have the camera focu on the
subject at the center of the screen automatically. To focus the camera on a subject
manually, press the MANUAL button, then press either FAR (to focus on the "far"
subject at the other location to which you have established a conference) or NEAR
(subject at your location) buttons to have the camera focus on the subject.

 

Zooming: Press any of the four ZOOM buttons.



 

Shooting with Back Lighting:  When you shoot a subject with a light source behind it,
the subject becomes dark. In such a case, press the BACK LIGHT button. Press the
button again the cancel the function.
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Presetting Feature
 

Having the camera memorize the setting:  Up to six combinations of settings (camera
position, zooming, focusing and backlighting) can be preset.

Press the PAN/TILT RESET button to reset the pan/tilt position. Be sure to
perform this step or else the correct position will not be memorized.

Note: The memorized information is retained until the power of the camera is turned off.
To retain the memory even after the power is turned off, set the BACKUP switch, at the
rear of the camera head, to ON.

1.  

Adjust the position, zooming, focusing, and back lighting of the camera.2.  
While holding down the PRESET button, press either of the POSITION buttons
1-6.

3.  

 

Recalling the memorized setting: Press any of the POSITION buttons 1-6 in which
you have stored a preset configuration.



Cancelling the preset memory:  While holding down the RESET button, press the
POSITION button on which the settings are to be cancelled.
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Auto Tracking Function
Basic Operations
Changing the Frame Position
If a Subject Cannot Be Recognized or Captured

 

Basic Operations:  The camera can recognize (also referred to as memorize) certain color and
brightness so that it automatically tracks a subject having the memorized color and brightness.
This function is called Auto Tracking.

Press the AT ON/OFF button to enter into the AT (auto track) mode setting. The frame and
setting values appear on screen. Although the frame normally appears in the middle of the
screen, you can change its position to a different location.

1.  

 

Press the ARROW button to perform the pan/tilt operation so that a subject is placed into
the frame.

2.  



 

To activate the Auto Exposure function to maintain the brightness of the subject
recognized above, press the AE button. This function automatically controls the back
lighting feature. To disactivate the function, press the button again. Be sure to do this
before proceeding with Step 3.

 

To activate the Auto Zoom function to maintain the displayed size of the subject
recognized above, press the AUTO ZOOM button.  To disactivate the function, press the
button again. Be sure to do this before proceeding with Step 3.
Press the START/STOP button to activate the AT function. Try moving the subject to see if
the frame tracks it automatically. When the frame tracks the subject, proceed with Step 4.

 

When the frame does not track the subject, repeat Step 3 while adjusting the lighting
and position of the subject so that the color and brightness of the subject is
optimized. If the frame still does not track the subject, try AT Troubleshooting for
more help.
Press the CHASE button repeatedly to cycle through the 3 chase modes until the❍   

●   



desired mode is selected.

Mode Tracking Method Intended Use
CHASE 1 The pan/tilt action is not performed

(camera does not move.) The frame
tracks a subject only within the range of
the screen.

Used to check if the
subject if recognized.

CHASE 2 The frame tracks a subject while the
pan/tilt action is performed. In this mode,
the subject is always placed in the middle
of the screen (or wherever the AT Frame
Position is set.)

Used to perform normal
tracking operation.

CHASE 3 Uses the same tracking method as
CHASE 1, except that if a subject almost
goes out of the screen, then the camera
performs the pan/tilt action so that the
subject is placed back into the middle of
the screen (or wherever the AT Frame
Position is set.)

Used when you wish to
limit the camera
movement while still
tracking the subject if
they move out of range.

If the frame is repeatedly extended to the full screen: This indicates the camera does
not recognize the subject. Press the START/STOP button and go back to Step 2. If the
subject still cannot be recognized, see AT Troubleshooting.

To toggle the setting value and frame display on and off:  If the setting value and/or
frame are displayed, they are part of the recorded picture. To turn off the Setting value,
press the DATA SCREEN button. To turn off the Frame, press the FRAME DISPLAY
button.

Note:  Once the setting value is turned off, it is not displayed until the next time you press the
DATA SCREEN button. However, the setting value is displayed automatically when the unit
enters into the AT setting mode for the first time after the power is turned back on.

If the light on the side of camera lens lights up: This indicates the camera is not
capturing the memorized subject correctly. Press the Arrow button to perform the pan/tilt
operation so that the subject comes into the screen. Or have the subject recognized onto
the camera again by performing Step 2.
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Changing the Auto Track Frame Position
 

During Auto Tracking, the frame normally appears in the middle of the screen, which is
the position on the screen where the camera will keep its subject. You can change this
frame location so that the camera maintains the subjects position in another location on
the screen.

Press the AT ON/OFF button to enter into the AT setting mode. The frame and
setting value appear. If the setting value does not appear, press the DATA
SCREEN button to have the value displayed.

1.  

Press the OFF SET button to enter into the AT frame position setting mode.2.  

 

Press the Arrow button to move the frame to the desired position.3.  



 

Press the OFF SET button to fix the frame position into its new location. After the
setting is completed, go back to Step 2 of Auto Tracking Basic Operations.

1.  
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Auto Track Troubleshooting
 

If a subject cannot be recognized or captured:  Depending on the characteristic or
condition of a subject, the camera might hardly recognize the subject. If the AT function still
does not work after the Basic Operation procedures, select an ENTRY mode that is matched
to contiditions under which the camera is used. Normally, try using ENTRY1 before changing
ENTRY modes to adapt to specific situations.

Problem ENTRY
mode to be
selected

Where to position
subject in the frame

Notes about this
ENTRY mode

A subject cannot be
recognized because its
color is too thin.

ENTRY 2 Place the subject so
that a relatively uniform
portion of color
brightness on the
subject is within the
frame.

 

The camera repeats
mistakenly recognizing a
new object whose color is
almost identical to that of a
subject. (The frame moves
from the subject to an
object whose color is
almost idential to that of the
subject.)

ENTRY 2 Place the subject so
that a relatively uniform
portion of color
brightness on the
subject is within the
frame.

The color and
brightness the
camera can
recognize is limited
in this mode, so try
ENTRY 1 mode first.



The camera does not
capture a subject correctly
when the brightness of the
subject changes as the
position of the subject
changes.

ENTRY 3 Place the subject so
that it hangs over the
frame slightly.

The frame flashes
for about 5 seconds
after the
START/STOP
button is pressed.
Within that period,
repeat changing the
angle of the subject
so that the camera
crecognizes the
various brightnesses
of the subject.

The camera repeats
mistakenly recognizing the
backdrop such as the wall
or ceiling. (The frame
moves from the subject to
the backdrop.)

ENTRY 4 Place the subject so
that the desired portion
fills the frame with no
background in the
frame whatsoever.

The color and
brightness the
camera can
recognize is limited
in this mode, so try
ENTRY 1 mode first.

Press the AT ON/OFF button to enter into the AT setting mode. The frame and setting
value appear. If the setting value does not appear, press the DATA SCREEN button to
have the value displayed.

1.  

Press the ENTRY button repeatedly to cycle through the 4 entry modes until the
desired mode is selected.

2.  

 

Have the camera memorize a subject by pressing the Arrow button to move the
subject into the frame. The position to which you place the subject varies depending on
the ENTRY mode you select (see table above.)

3.  

Press the START/STOP button to activate the AT function. Try moving the subject
again to see if the frame now tracks it automatically.

4.  
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Motion Detector Function
 

Basic Operations:  If the position of the camera is fixed (no Auto Tracking is being
used), the camera can be set to detect a change (motion) taking place in a picture.
When the camera detects a change taking place in the picture, the frame appears,
showing the portion in which the change takes place, and the light at the side of the
camera lens turns red. Up to two frames may be memorized in any position and size
that is desired.

Press the MD ON/OFF button to enter into the MD setting mode. The frame a
setting values appear.

1.  

 

Press the FRAME button to enter into the detection frame setting mode.2.  



 

Decide the position and size of the first frame to be detected (FRAME 1).
Press the Arrow button to set the position of FRAME 1. Then press the
FRAME button to accept this setting.

●   

3.  

 

Then, press the Arrow buttons to set the size of FRAME 1. Then press the
FRAME button to accept this setting.

●   

 

Repeat Step 3 to set a position and size for FRAME 2, if desired.4.  
Press the DETECT button repeatedly to cycle through the 3 frame detect modes
(including an option to detect both frames simultaneously) until the desired mode
is selected

5.  



 

Press the START/STOP button to activate the MD function.6.  

 

To toggle the setting value and frame display on and off:  If the setting value and/or
frame are displayed, they are part of the recorded picture. To turn off the Setting value,
press the DATA SCREEN button. To turn off the Frame, press the FRAME DISPLAY
button.

Note:  Once the setting value is turned off, it is not displayed until the next time you press
the DATA SCREEN button. However, the setting value is displayed automatically when
the unit enters into the AT setting mode for the first time after the power is turned back on.

Cancelling the MD function:  Press the START/STOP button. To exit from the MD
mode, press the MD ON/OFF button.

Note:  Once the frame is set, it remains memorized until the power is turned off. To retain
the memory of the frame setting even if the power is turned off, set the BACKUP switch, at
the rear of the camera head, to ON.
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If You Need Support:
Try the TeamStation F1 Help key first.

Client Services at x4171. 
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NREL Intel® TeamStation™ System Locations
Following is the list of TeamStation names available, as well as the building and room
numbers where they are located. After scheduling use of the conference room, contact
the individual listed for each TeamStation system to check out the keyboard and
remote, and remember to return them to the contact person when you are finished.

TeamStation Name Building/Room Number Contact
team-16_316 16/316 Richard Parish
team-17_1b 17/1B Nick Dean
team-17_3a 17/3A Nick Dean
team-27_230 27/230 Pam Lee Bull
team-dc_718 NREL DC/718 Wanda Addison
team-nwtc_115 NWTC/115 Jim Mittl
team-serf_c206 SERF/C206 Paula Robinson
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NREL Standards for Desktop Real-time
Collaboration
The NREL standards for Desktop Real-time Collaboration are still being investigated.
Standard desktop applications for Mac and PC are currently planned for roll-out during
the 4th quarter of 2000.
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